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Adding Device(s) to the
CodeWarrior Flash Programmer
for ARMv8 Processors

1 Introduction

This document explains how to use the Flash Tool Kit to
support additional flash devices on the Flash Programmer for
CodeWarrior Development Studio for ARMvS8 Processors by
creating new programming algorithms and support files. To
add support for a new flash device, you need to write a new
flash programming algorithm.

This document explains how to:
* Create a flash device XML configuration file
» Create new target task flash device algorithm XML
* Create a flash device parameters XML
» Use an existing flash algorithm
* Create an external flash algorithm

2 Preliminary Background

Before you program or erase any flash device, ensure that the
CPU can access the flash device. For example, you might need
a different debug setup that requires modification to the
debugger configuration file.

Consider the following before you begin:
* Read the flash device ID to verify the correct connection
and programmability. The section QSPI algorithm
example provides you with instructions.
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A ———
Flash Tool Kit (FTK) Overview

NOTE

Many manufacturers use the same flash device algorithms, so it is likely that
flashes can be programmed using the algorithms included with the CodeWarrior
software.

* Check whether the new flash device can be programmed with one of the existing flash programmer algorithms.

» Refer to the section Select Flash Programming Algorithm to determine if the flash device is programmable with an
algorithm already included with the CodeWarrior software.

» Follow the steps in section Creating External Flash Algorithm if the flash device cannot be programmed with an
existing algorithm.

3 Flash Tool Kit (FTK) Overview

Adding a new flash device support requires few new files, including:
* xml configuration file for the new device, which describes the organization
» xml configuration file for the board, which specifies the flash it must use and, where is the RAM memory located, and.
* flash device algorithm, if none of the existing algorithms are compatible

4 Creating Flash Device using existing algorithm

In its default configuration, the CodeWarrior Flash Programmer for Power Architecture ARMvS8 supports many flash
devices. The configuration files are located at

{CodeWarrior}\CW ARMv8\Config\flash\devices
To add a new device to the CodeWarrior flash programmer, you must add a new file that describes the device.

Generic flash device file format

<device-files>
<devices
<content>
<device paramteres>
<device_ typesDeviceType</device types
<manufacturerid>MfgID</manufacturerids>
</device parameters>
<name>NameOfFlashDevice</name>
<sectors>
<sector count=“numberOfSectors” size="sectorSize”/>
</sectorss>
<organizationss>
<organization depth="Capacity” width="buswidth” count="noOfDevices”>
<id>DeviceID ForBusWidth</id>
<algorithms>
<algorithm>
<fpinclude href="pathToAlgorithm"/>
</algorithm>
</algorithms>
</organization>
</organizations>
</content>
</device>
</device-file>

To add flash programming support for a new flash device:
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Creating Flash Device using existing algorithm

* Locate the data sheet for the new device and note the following information about the flash device:
* Device name
* Manufacturer ID code
* Device type
* Number of sectors
» Sector size
» Capacity and bus width
* Which device is most similar in the device configurations
» Examine the installed devices for the most similar definitions.
» Copyl/edit the definition to make the xml device files conform to the new device.

4.1 Device Name

This is a free-form text field that describes the flash device, taken directly from the data sheet. Use only displayable ASCII
characters with no spaces.

The format is:

<name>NameOfFlashDevice</name>

4.2 Manufacturer ID Code and Device ID Codes

These Manufacturer ID and Device ID are read from the flash device after a specific sequence of writes to the flash device.
Although, the data sheet lists both of the ID’s, only the Device ID varies among the flash devices from a given vendor, as the
Manufacturer ID remains the same. If the flash device supports more than one bus width (8-bit, 16-bit), then it might have
different Device ID for each mode.

The formats are:

<manufacturerid>MfgID</manufacturerids>
<id>DeviceID ForBusWidth</id>

4.3 Device Type
Each device has a certain type (NOR, NAND, SD, QSPI) which can be taken directly from the data sheet.

The format is:

<device type>DeviceType</device type>

4.4 Number of Sectors and Sector Size

The data sheet lists the information on sector and sector size. If the data sheet lists sector maps and tables for both 8-bit and
16-bit data options, use the 8-bit data option. The CodeWarrior flash programming algorithms require byte-level addresses
for each sector. This constraint simplifies the design of the CodeWarrior flash programming interface for several data-bus
configurations and sizes. When the data sheet does not provide a byte level address, the algorithm creates an 8-bit sector map
for 16-, 32-, or 64-bit devices. Table 1shows an example of converting a 16-bit sector map to an 8-bit map.

The formats are:
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Creating Flash Device using existing algorithm

<sector count="sectorcount" size="sectorsize"/>
The sectorcount value is decimal while the sectorsize is hexadecimal.
For example, consider S25FS5128S. The device has 256 sectors of 0x40000 bytes each.

The configuration file will contain:

<sectors>
<sector count="256" size="0x40000"/>
</sectors>

4.5 Options for Organization Name

The information that must be specified here, as an organization name, includes: device size, bus width, and number of
devices present on board.

Device size is the size of the device. It can be expressed as KB or MB using K and M suffixes. Examples: 128K, 1M.

Many flash devices can be set to use either 8-data bits or 16-data bits depending on the status of a configuration pin (typically
named BYTE#) on each device. The <organizations> field uses this part of the flash definition, as described in the next
paragraph. Your target uses only one configuration so you need to support only that configuration. Expanding your new
definition to include the other configurations for this device, however, is good design practice. Your target may use one, two,
or four devices at the same base address to support an 8-bit, 16-bit, 32-bit, or 64-bit data bus.

For example, two 8-bit flash devices side by side support a 16-bit data bus, and four 16-bit devices support a 64-bit data bus.
The <organizations> field summarizes each possible combination of device capacity, bus width, and number of devices
used.

The format is:

<organizationss>
<organization depth="Capacity” width="bus_ width “count="NoOfDevices”>
<id>0x4a54</id>
<algorithmss>
<algorithms>
<fpinclude href="path to algorithm xml"/>
</algorithm>
</algorithms>
</organization>

</organizations>

4.6 Find Most Similar Device

To find a device most similar to the one for which support is introduced, perform these steps:

* From the data sheet for target flash devices, determine whether the bus width is 8- or 16- data bits.
* Read through the files in the configuration folder of the CodeWarrior™ Development Studio for ARMVS installation
and scan for devices from the same manufacturer with similar part names.

For example, SL29GLO1GN is similar to SL29GL0O1GS.

* Manufacturers often base new designs on the architecture of previous designs to ensure that new devices are virtually
the same as the previous devices. However, the new devices may have greater capacity or improved programming
features, such as timing and operation. This pattern simplifies flash programming because the flash programming
algorithms remain unchanged. Yet only the device names, sectors, and Device IDs change.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017

4 NXP Semiconductors



4
Creating External Flash Algorithm

4.7 Select Flash Programming Algorithm

Flash programming algorithms differ depending on the flash manufacturer, bits per device organization, and the number of
the flash devices used. The CodeWarrior flash programmer supports a number of algorithms. These files can be found at:

{CodeWarrior}\CW_ARMv8\Config\flash\algorithms

The CodeWarrior Development Studio for ARMv8 has built-in flash programming algorithm support for a number of flash
devices. If the device does not have built-in algorithm support, you can create your own algorithm and use it with the
CodeWarrior flash programmer. For more information, see Creating External Flash Algorithm.

Copy the algorithm that you choose to use and rename it the same as your device configuration file (do the same with the
parameters file from the “params” folder). Now, in the new algorithm xml, change the name and the parameters xml path.

For example, let’s consider we’ve created the NewDevice.xml configuration file that is similar to S25FS512S. We will make
a copy of the algorithm S25FS512S.xml and rename it NewDevice.xml and a copy of the parameters file
S25FS512S_QSPI_64.xml and rename it NewDevice_64.xml. Then, in the algorithm xml, we will modify the following lines
as follows:

Old:

<name>S25FS512S</name>
<fpinclude href="algorithms/params/S25FS512S QSPI 64.xml"/>

New:

<name>NewDevice</name>
<fpinclude href="algorithms/params/NewDevice 64.xml"/>

After that, modify your board initialization file from the Target Connections Configuration. Locate the following line:

gdb.execute ("fl device --alias gspi --name S25FS512S --address 0x40000000 --waddress
0x10000000 --wsize Ox1FFFF --geometry 8xl --controller QSPI")

Replace “S25FS512S” with the name of your device (in our example, that would be NewDevice).

5 Creating External Flash Algorithm

5.1 Preliminary Background

Before you program or erase any flash device, you must ensure that the CPU can access it. For example, you might need a
different debug setup that requires modifications to the debugger configuration file. Consider the following before you begin:
* Read the flash device ID to verify correct connection and programmability. Refer to QSPI algorithm example for
instructions
* Many manufacturers use the same flash-device algorithms, so it is likely that flashes can be programmed using
algorithms included with CodeWarrior software. In addition, many manufacturers produce devices compatible with
Intel or AMD.
* Check whether a new flash device can be programmed with an algorithm already included with the CodeWarrior
software, as described in Select Flash Programming Algorithm.
* Follow the steps in Creating External Flash Algorithm if the flash device cannot be programmed with an existing
algorithm.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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Creating External Flash Algorithm

5.2 Flash Tool Kit (FTK) Overview

The Flash Took Kit helps you develop flash programming algorithms for the CodeWarrior Flash Programmer. This section
provides important information needed before you begin creating a flash programming algorithm.

.5 Project Explorer 2 M Target Connections

4 =5 FlashTemplate
¥ Binaries
mi Includes
4 5 headers
4 (= common
v ARMflash_commands.h
in ARMgeneric.h
i generich
4 (B source
4 = common
e ARMflash_main.c
i) ARMgeneric.c
- |5 exception.S
IS start.S
4 = specific
td Algornithm_Template.c
&> Debug_FlashTemplate

» htmi
= latex
4 = linker_Files
| aarchbdelfx

Figure 1. Target Connections

5.3 Flash Tool Kit General Structure

* ARMflash_commands.h — contains the declarations of the flash functions implemented in Algorithm_Template.c
* ARMgeneric.h — contains the declarations of the utility functions implemented in ARMgeneric.c

» generic.h — contains the definition of some macros and the parameter block structure

* ARMflash_main.c — the main function and API to the CodeWarrior Flash Programmer

* ARMgeneric.c — utility functions used for reversing endianness for different data types

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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Creating External Flash Algorithm
* Exception.S and start.S — these files should not be modified

* Algorithm_Template.c — contains the implementation of the Flash Programmer functions.

5.4 Flash Tool Kit Build Target

33' Properties for FlashTemplate _E_X |
type filter text C/C+ + Build i T
Resource [
Builders
. C/C++ Build Configuration: |Debug_FIashTempIate [ Active | B ‘ [Manage Configurations._.‘

» C/C++ General
Linux Tools Path

= Builder Settings |.-§;, Behaviorl «* Refresh Policy

Project References
Refactoring History Builder
Run/Debug Settings

Ruilder tuna: [F\rh:hrn:al huildar v|

The Flash Tool Kit Build Target is Debug_FlashTemplate. Building the target will generate a BIN file which will later be
used to add the custom algorithm.

5.5 Flash Programmer API

Parameter_block_t Structure
For the detailed description of the Parameter_block_t structure refer to Listing 4.

Parameter_block_t structure details

typedef struct pb {

unsigned long function; /* What function to perform ? */
pointer t base addr; /* where are we going to operate */
unsigned long num_items; /* number of items */

retval t result status;

pointer t items;

} parameter block t;

Listing definitions:

* function — command from CodeWarrior Flash Programmer to be executed.

* base_ addr — start address of the flash memory.

* num_items — number of items to be transferred from the CodeWarrior Flash Programmer to the flash programming
applet.

* result_status — status of the command; through this field, the flash programming applet notifies the CodeWarrior
Flash Programmer about the status of the command being executed. Some values for result_status are defined in
generic.h; however, the user can define more, if necessary.

* items — start address of the data to be transferred from the CodeWarrior Flash Programmer to the flash programming
applet.

NOTE
items and base_addr are of type pointer t, which is a union that can
accommodate different types (char *, short *, etc.) This arrangement makes
the algorithm scalable, so it can be used for 8-bit, 16-bit or 32-bit flash;

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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Creating External Flash Algorithm

5.5.1 retval_t ID(parameter_block_t* p_pb)

Function called when reading device ID.

Parameters

parameter block t* p pb pointer to a parameter_block_t structure

Returns: retval_t type is always returned.

5.5.2 retval_t flash_dump (parameter_block_t * p_pb)

Function called when exporting data from flash memory.

Parameters

parameter block t* p pb pointer to a parameter_block_t structure

Returns: retval t type is always returned.

5.5.3 retval_t flash_erase (parameter_block_t * p_pb, uint32_t

iSector)
Function called when erasing a sector from flash memory.
Parameters
parameter block t* p pb pointer to a parameter_block_t structure
uint32 t iSector a 32 bit unsigned integer, representing the sector index

Returns: retval_t type is always returned.

5.5.4 retval_t flash_protect (parameter_block_t * p_pb, uint32_t
sect_index)

Function called when protecting a sector in flash memory.

Parameters
parameter block t* p pb pointer to a parameter_block_t structure
uint32 t sect_index a 32 bit unsigned integer, representing the sector index

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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Creating External Flash Algorithm

Returns: retval t type is always returned.

5.5.5

retval_t flash_unprotect (parameter_block_t * p_pb, uint32_t
sect_index)

Function called when unprotecting a sector in flash memory.

Parameters
parameter block t* p pb pointer to a parameter_block_t structure
uint32_ t sect_ index a 32 bit unsigned integer, representing the sector index

Returns: retval t type is always returned.

5.5.6

retval_t flash_write (parameter_block_t * p_pb)

Function called when writing bytes into flash memory.

Parameters

parameter block t* p pb pointer to a parameter_block_t structure

Returns: retval_t type is always returned.

5.6 Create New Flash Programming Algorithm

In this section, step-by-step instructions show you how to use the Flash Tool Kit to create a new CodeWarrior Flash
Programmer flash programming algorithm for a flash device, which is not integrally supported by the CodeWarrior software.
1. Copy FlashTemplate folder from {CodeWarrior}\CW_ARMv8\ARMv8\CodeWarrior Examples to a different
directory from where you will import the project.
2. Import the FlashTemplate project:

a.

File -> Import. The Import dialog box appears.

b. Select General -> Existing Projects into Workspace and click Next. The Import Projects page appears.
c.
d. The Projects list will show all available projects in the FlashTemplate folder. If you see projects other than

Click Browse to select the parent folder where you have copied the FlashTemplate folder.

FlashTemplate, then deselect all other projects and click Finish.
Ensure Debug_FlashTemplate build target is selected (Project -> Properties -> C/C++ Build).

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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Creating External Flash Algorithm

ﬁ- Properties for FlashTemplate

type filter text

Resource
Builders

» C/C++ Build

» C/C++ General
Linux Tools Path
Project References
Refactoring History
Run/Debug Settings

- Task Repository
WikiText

bl

C/C++ Build

Configuration: {Debug_ﬁash’[‘emplate [ Active ] 'J [Manage Configurations...

E Builder Settings | @ Behavior | 4 Refresh Poliwi

Builder

Builder type: [Extemal builder > I

[¥] Use default build command

Varnables.

Build command: | ${cross_make}

Makefile generation

[V] Generate Makefiles automatically V| Expand Env. Variable Refs in Makefiles

Build location

Build directory: | ${workspace_loc:/FlashTemplate}/Debug_FlashTemplate

Variables

Implement the algorithms. ( Note: for the purpose of this example, we will leave the algorithms blank ).
Build the project (Project -> Build Project).
In the Debug_FlashTemplate directory, open the FlashTemplate.map file and scroll down to the __start address. Write

it down as it will be used later when creating the xml files.

Fiie EQIT 30UNCE KEf3CTor  Navigare

-
Lol

{&5 Project Explorer & H
+ {¥ FlashTemplate
+* Binaries
&) Includes
+ 2 headers
& source
« = Debug_FlashTempilate
= source
. 15 FlashTempiateslf - [none/le]
! FlashTemplate.bin
% FlashTemplate st
¥ FlashTemplatemap
& makefile
@& objectsmk
L& sources.mk
= html
v latex
= Linker_Files

BB~ Ngroiy v rH>0rR Q> & iivan v’

SEBFCN FTOFECT  KUN  FrOCESSOr EXPErT  VWINOOW “HeiD

o -

vem

= % ¥

1 FashTempiate.map &

Ax0en20ReRenRen3ng 8x8 ./source/common/ARMgeneric.o
ax008000e0e0008394 flash_exit

Ctext.getDataOffset
AxB00200000000030 @xlc ./source/common/ARMgeneric.o
Ax008020000000080359C getDataOffset

.text.Swap32InPlace
Bx0202e0000000030b8 Bx5¢c . /source/common/ARMzeneric.o
Gx00000000000003b8 Swap32InPlace

Jtext.Swap32  Ox0e000000e0p00414 Bx4c . /source/common/ARMgeneric.o
9x3000000000080414 Swapi2

Ltext . Swaple  Ox0000002000000460 Bx3¢ . /source/common/ARMgeneric.o
2x0002000000000460 Swaplé

Ltext.Swapl6InPlace
Ax0e000002600049c Bx48 . fsource/common/ARMgeneric.o
Bx030000002080040c SwapleInPlace

*fill* Ax0000000000000424 Gxlc 00800000

Ltext AxA002000020080500 @x8e@ . /source/common/exception.o
Ax0202800000080500 LS3 vectors

Jtext 2x8000000000000d00 @xe@ ./source/common/start.o
AxBe00080006000d00 __internal_get_offset_label
8x00000000000008d1c __start

*{.gnu.warning)

find

*(SORT(.fini))
2xP000000000000den PROVIDE (__etext, .)
Ax0000000000000de0 PROVIDE (_etext, .)
2xB0000000000008de0 PROVIDE (etext, .)
AxB000000000000de0 . = ALIGN (8x2@)
Ax0262000000000de0 _end__ = .
Ax0200002000082de0 end = .

7. Create the parameters xml in {CodeWarrior}\CW_ARMv8\Config\flash\algorithms\params

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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Creating External Flash Algorithm

E(params_file}

=] <parameters block>
<param name="fonction" size="0x4"/>
<param name="paddingl" size="0x4"/>
<param name="base addr" zize="0x8"/>
<param name="num items" size="Dx4" t;pe=“data_size“/>
<param name="resolt statns" size="0x4" type="result"/>
<param name="items" size="0Dx8" type="data inout"/>:

- </parameters block>

~</params file>

This is the template for the most basic parameter file. Here is where you find the supported functions and where you
can add new parameters used for the parameter block structure.

8. Create the algorithm xml in {CodeWarrior \CW_ARMyv8\Config\flash\algorithms.

l<algorithm-file>
] <architecturesy
1 <architecture ‘type="arm" -raddress size="64">
1 <controller type="QSPI":»
<format>bin</format>
<entry_point>030d93<ientry_point}
<file>FlashTemplate</file>
<fpinclude href="algorithms/params/FlashTemplate 64.xml"/>
1 <supported operations>
<operation>id</operation
<cpeIation>erase_§ectors<fcperation>
<operationr»program<,/operation>
<gperation>domp</operation>
<operation}protect_sectors<ioperation}
<opeIati0n>unprotect_sectorsCioperation>
<l5uppcrted_cperations>
</controllers>
</architecture’>
</architectures>
-{falgcrithmrfile>

The architecture type and address_size are taken from the CPU. Controller type mush match the one specified in the
console command. Format is always bin. Entry point is the address you’ve written down at step 5). The last is the path

to the parameters xml.

9. Create the device configuration xml in { CodeWarrior N\CW_ARMYv8\Config\flash\devices.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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Creating External Flash Algorithm

<device-Filed
<device>
<content>
<device parameters>
<device_type>spi<idevice_type>
<manufacturerid>0x01</manufacturerids>
</device parameters>
<BEeCCOrs>
<gector count="256" =ize="0x40000"/>
</sectors>
<organizations>
<organization depth="64M" width="8">>
€id>0x0102</id>
<algorithms:
<algorithms>
<fpinclude -href="algorithms/FlashTemplate.xml" />
</algorithm>
</algorithms>
</organization>
</organizations>
</content>
</device>
<fdevice-file>

The device configuration xml has been explained in Creating Flash Device using existing algorithm.

10. In the CodeWarrior Target Connections Configuration tab, modify the target initialization file for the board you are
using, as follows:

gdb.execute ("f1 device —-zli=z

[T
fie}

Insert the name of your device configuration xml.

11. Now, in the Flash Programmer, you should be able to see your new flash device.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
12 NXP Semiconductors




4
QSPI algorithm example

' CodeWarrior Flash Programmer =i,
Perform actions on the flash device
Devices: |FlashTemplate (@57D ~| ® Connected to: LS1012A, cwtap: USB
_Sequence-'
Actl'-::m:inglam - File: = - .Bfﬂ-'IHSEE
Offset: | Unprotect |v|Erase | | Verify | | Protect
il I |
D s X & < tay ok
Action Description
M
@ ¥
)

6 QSPI algorithm example

An overview of the QSPI algorithm, the supported commands and the parameters XML file.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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QSPI algorithm example

6.1 Algorithm overview

4 @ common
4 (= headers
¢ [b generich
b [ utils.h
4 = linker files
= aarchbdelfx
4 (= sources
. [8 exception.S
- 8 start.S
> [€ utils.c
4 (B headers
4 (= common
- [n ARMflash_commands.h
- W ARMgeneric.h
4 (= specific
- [B gSPLInterface.h
. [n gSPI_Parameters_Structure.h
. [B gSPLh
4 (2 source
4 = common
> [¢ ARMflash_main.c
- g ARMgeneric.c
4 = specific
- [€ gSPI_Algorithm.c

Figure 2. QSPI algorithm

 generic.h — header containing different types of operations, errors and a somewhat generic pointer type.
* utils.h — utility functions for treating data endianness, getting the offset to the parameter structure, reading/writing
registers.
* aarch64elf.x — linker file.
* exception.S — exception handler code.
* start.S — calculates the entry point and other configurations.
* utils.c — implementation of the functions found in utils.h.
* ARMflash_commands.h — functions used for programming the flash (id, dump, write, erase, protect, unprotect).
* ARMgeneric.h — defines some parameters used for determining the soc configuration.
* gSPIL_Interface.h — QSPI register layout.
* gSPI_Parameters_Structure.h — structure containing the parameter block.
* function — the function to perform.
* paddingl — needed for aligning the structure to a 64-bit boundary.
* base_addr - start of the flash memory where we are going to operate.
e num_items — number of items in the buffer.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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QSPI algorithm example

result_status — operation status.

items — pointer to a data buffer.

qspi_base_addr — base address of the gqspi region in the SoC memory map.
gspi_controller_offset — offset to the qspi controller in memory.
block_protect_mask — a mask used for determining which bits of the status register are used for block protection.
bytes_per_sector — number of bytes which comprise a sector.

bytes_per_page — the number of bytes of a page.

number_of _sectors —how many sectors are there in the flash.

swap_enable — endianness flag.

workaround — parameter used for applying device specific configurations (like uniform sector enable).
is_nand — flag used for identifying whether the device is QSPI Nor or QSPI Nand.
write_enable_cmd — write enable command code.

read_id_cmd — read id command code.

read_id_dummy — read id dummy cycles.

read_id_length — read id command read length.

read_status_register_cmd — read status register command code.
read_status_register_address_length — read status register command address length.
read_status_register_length — read status register command read length.
write_status_register_cmd — write status register command code.
write_status_register_address_length — write status register command address length.
write_status_register_length — write status register command read length.
read_any_register _cmd — read any register command code.
read_any_register_address_length — read any register command address length.
read_any_register_dummy — read any register command dummy cycles.
read_any_register_length — read any register command length.
write_any_register_cmd — write any register command code.
write_any_register_address_length — read any register command address length.
write_any_register_dummy — read any register command dummy cycles.
write_any_register_length — read any register command length.

page_read_cmd — page read command code.

page_read_dummyl — page read first dummy cycle.

page_read_address_length — page read command address length.
page_read_dummy?2 — page read second dummy cycle.
page_read_from_cache_cmd — page read from cache command code.
page_read_from_cache_dummyl — page read from cache first dummy cycle.
page_read_from_cache_address_length — page read from cache address length.
page_read_from_cache_dummy2 — page read from cache second dummy cycle.
page_program_cmd — page program command code.

page_program_dummy — page program dummy cycle.
page_program_address_length — page program command address length.
page_erase_cmd — page erase command code.

page_erase_dummy — page erase dummy cycles.

page_erase_address_length — page erase command address length.
page_execute_cmd — page execute command code.

page_execute_dummy — page execute dummy cycles.
page_execute_address_length — page execute address length.

die_select — die select command code.

die_index — die index.

padding — used to align the parameter structure.

gSPLh — defines some command ids, lookup table instructions and declares some general gspi functions.
ARMflash_main.c — the main function and logic loop.

ARMgeneric.c — autodetect SoC function definition.

gqSPI_Algorithm.c — definitions of all the flash commands and gspi utility commands.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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QSPI algorithm example

6.2 Functions

fID:

The id command is called by CodeWarrior Flash Programmer to read the Manufacturer and Device ID of the chip. For the
fID command, the CodeWarrior Flash Programmer:

* loads the flash programming applet to the target board,

¢ sets the command fID, as shown in the function field,

* runs the flash programming applet,

 waits while the flash applet stops execution,

* checks the status of the command being executed, as shown in the result_status field.

fEraseSector:

The CodeWarrior Flash Programmer calls the sector erase command to erase a set of flash memory sectors. For the
fEraseSector command, the Flash Programmer:

* Jloads the flash programming applet to the target board,

¢ sets the command fEraseSector, as shown in the function field,

* specifies number of blocks to be erased, as shown in the num_items field,

* specifies start-up address of each block to be erased, as shown in the items field,

* runs flash programming applet,

» waits while flash applet stops execution,

 checks the status of the command being executed, as shown in the result_status field.

fWrite:

The fWrite program buffer command is called by the Flash Programmer to program a set of values at a specific address. For
the fWrite command, CodeWarrior Flash Programmer:

* Jloads the flash programming applet to the target board,

¢ sets the command fWrite, as shown in the function field ,

* specifies number of bytes to be programmed, as shown in the num_items field,

* specifies start-up address of data to be programmed, as shown in the items field,

* runs flash programming applet,

» waits while flash applet stops execution,

 checks the status of the command being executed, as shown in the result_status field.

fDumpFlash:

The dump flash command is called by CodeWarrior Flash Programmer to read the values at a specific address and output it.
For the fDumpFlash command, the CodeWarrior Flash Programmer:

* loads the flash programming applet to the target board,

* sets the command fDumpFlash, as shown in the function field,

* specifies number of bytes to be read, as shown in the num_items field,

* specifies start-up address of data to be read, as shown in the num_items field,

* runs the flash programming applet,

 waits while the flash applet stops execution,

* checks the status of the command being executed, as shown in the result_status field.

fProtectSector:

The protect sector command is called by CodeWarrior Flash Programmer to protect a number of sectors in the flash. For the
fProtectSector command, the CodeWarrior Flash Programmer:

* loads the flash programming applet to the target board,

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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¢ sets the command fProtectSector, as shown in the function field,

* specifies start address to be protected,

* specifies number of bytes to be protected,

* runs the flash programming applet,

» waits while the flash applet stops execution,

 checks the status of the command being executed, as shown in the result_status field.

fUnprotectSector:

The unprotect sector command is called by CodeWarrior Flash Programmer to protect a number of sectors in the flash. For
the fUnprotectSector command, the CodeWarrior Flash Programmer:

* loads the flash programming applet to the target board,

* sets the command fUnprotectSector, as shown in the function field,

* specifies start address to be unprotected,

* specifies number of bytes to be unprotected,

* runs the flash programming applet,

 waits while the flash applet stops execution,

* checks the status of the command being executed, as shown in the result_status field.

6.3 Building the algorithm (only if the sources were modified)

In order to build the QSPI algorithm, perform the following steps:

1. Import the QSPI algorithm sources:
a. Click File -> Import. The Import dialog box appears.
b. Select General ->Existing Projects into Workspace and click Next. The Import Projects page appears.
c. Click Browse and navigate to the QSPI algorithm sources located at:

{CodeWarrior}\CW_ARMv8\ARMv8\CodeWarrior Examples\FlashSDK\

d. The Projects list will show all available projects in the folder. Select the QSPI_algorithm project.
2. Right-click the project and select Build Project.
3. Copy the resulted binary in the {CodeWarrior}\CW_ARMv8\Config\flash\arm\bin folder.

6.4 Parameters XML

The parameter XML located in the {CodeWarrior}\CW ARMv8\Config\flash\algorithms\params folder has the
following structure.

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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<params file>
<paramerts l‘.'!_hlt'l: k>
<param name="function”™ size="0x4"/ >
<param name="paddingl” size="0x4"/>
<param nams="hase addr® size="0xg"/>
<param name="nom items" size="Ox4" type="data siza"/>
<param name="result statos” size="0x4" type="Tesolt"S >
<param name="jtems" size="Ox8" cype="data inout"/>
<param name="gsp 1‘}1&4#‘___&.!1‘11’ " size="OxX8"/>
<param name="gapi eontroller offset" size="0ad"/>
<param name="bytes per sector" size="(Ox4" value="Dx40000"°/>
<param nama-'hytas:ber:ﬁngn" srza="0xd" value="0x200"/>
<param name="pumber of sectors” size="0x4" value="0x100"/>
<param name=" :wa.p_ana.ble o osize=mtOxl"/»
<param name=S"workaronond® size="0xl" valus="1"/>
<param name="is nand" aize="0xl" wvalue ="0"/>
<param nanﬁ-"hlsﬁkkprntect_naqk“ siza="iyxl" valpe="OxiC"/ />

«l—— yrite-snabhle —3
<param name="write enable omd" =ize="0xl" value="[0x06"/>

€l== roamd id ==3

<param name="read id cmd" size="0xl"™ value="0x3F"/>»
<param nama=S rn.ad:1 d:dmmy“ slze="0xl" value="0x0"/>
<param name="read id length" size="Dx1® value="0x08%S>

<i== read scatus regiscer =-=3>

<parai name=" ru-ﬂ.d_t L‘.-ﬂ.tn-ii_:‘:l:i ] ll:r_l:-d " size="Ox1" valus="DxD5"/ >

<param name="read statos register address langth” size="0xl" wvalue="0x0°/>
<param name="read statuos register length"” size="0x1" value="0x01"/>

£lm= yrite sacatu® regiscer =-=3

<pAram nAame="Write atatus register omd" size="0xl" wvalue="0x01"/>

<param name-"nrltuiktatns:rsqzﬂtsr:addrﬂss_langth“ size="0xl" yvalpe="0x0"/>
cparam names"write statos register length" size="0xl" value="0Dx01"/>

£!== rTead any register ==->
<param nampe=s md__any__mi ] l'.et‘_tﬁd 'oalzamnOxl” walus="0xE5" />
<param name="read any register address length® size="0x1" value="0x18"/>
<param neme="read any register dummy” size="0Dxl" value="DxB"/>
<param ngmz-“rﬂad:ﬁuy:rQQIster:inngth" srlza="0xl" valus="(0x1"/>

41— Write-any regiacer —>»
<param name="write any register omd" size="Oxi" valus=%0x7i%/>
<param name="wri 'l:e__u:ruf_ruq iste t‘_ﬂdd.‘n!l#_lthﬂth"' sizes"0x1" valus="OxIB"/>
<param name="write any register dommy® size="0x1" value="0x0"/ >
<param name="write any register length® size="Oxl1" value="0x1%/>

L fm= page read (NOR) / read to cache (HAND) ==

<param name="page read omd" size="0xl" value="Dx0OC"/S>

<param namt-"paqn:;sai:dm-uyl" mize="0x1" valus="Q0x0"/>

<param name="page read address length” size="0Ox1" value="(x20"/>
<param name="page read dopmy2" size="0Ox1" value="0x08"/>

41—~ read from cache  (NAND) —>

<param name="page read from cache omd” - -=ize="0x1" value="0x13"/>

<param name="page read from cache duommyl"” size="0x1" value="DxB"/>

<param nams="page read from cache address length® size="0x1" value="0x10"/>
<param name="page read from cache dummy2" size="0xi" value="0x8"/>

Adding Device(s) to the CodeWarrior Flash Programmer for ARMv8 Processors, Rev. 1, 03/2017
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<l—— page program ——>

<param name="page program omd" size="0x1" wvalue="0x12"/>

<param name="page programn dummy" size="0x1" wvalue="0x0"/>

<param name="page program address length" size="0x1" value="0x20"/>

< 1—— page erase —>
<param name="page erase cml" s3ize="0x1" wvalue="0xDC"/>
<param name="page erase dummy" size="0x1" value="0x0"/>

<param name="page erase address length" size="0x1" value="0x20"/>
«!—— program execute ——>
<param name="page execute cmd" size="0x1" value="0x0"/>

<param name="page execnte dunmy" size="0x1" wvalue="0x0"/>
<param name="page execute address length" size="0x1" wvalue="Dx0"/>

Al == fip selEsh - =—3
«param name="die select" size="0x1" value="0Dx0"/>
<param pame="die index" size="0x1" value="0x0"/>

<param name="padding"” size="0x3"/>
</parameters block>
</params file>

Figure 3. Parameters XML

Each line must contain the following:

* name — must match the name of its corresponding field in the parameters structure.

* size — how many bytes it occupies, must match the size of the data type of the parameter in the parameter structure.

* type (optional; default is “in”) — input/output/data_size.

* value (optional) — the value stored in the parameter. Must be set in the xml according to the flash device manual. A
value of 0 means that the operation is not supported.

NOTE
Additional padding might be needed for the alignment of the structure.

The parameter structure tries to accommodate most of the QSPI flash devices, but there might be certain cases where
additional parameters might be needed. This means the algorithm has to be modified and rebuilt. Also, if the modified
parameters structure exceeds the size of 0x100, it’s entry point must be modified in both the linker file and the algorithm
XML.

6.5 Algorithm XML

The algorithm XML located in the {CodeWarrior}\CW _ARMv8\Config\flash\algorithms\ folder has the following
structure.
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<algorithm-file>
<architectures>
<architecture type="arm" address size="64">
<controller type="QsPI">

<format>bin</format>

ientry_pn1nt>DxlDDiIEﬂtIy_lent>

{file}QSPI_§4b{Ifile>

<fpinclude h:ef=“algarithmsfparamsfSQEFSSIQS_QSPI_Ed.xml“j}

<supported operations>
<operation>id«</operation>
{Dperat10n}erasg_;ectars<£nperat10n}
<operationr>program</operation>
<operation>dump</ocperation
{DpexatiDn}pratect_sectnrs<fupexatinn}
<operaticonrkunprotect sectors</operaticonl

<f5uppcrted_cperaticn5}

</controller>
<farchitecture>
</architectures>
«/algorithm-file>

Figure 4. Algorithm XML

architecture
* type —the CPU type.
* address_size — the size of an address in bits.
controller type — the type of the flash device.
format — extension of the algorithm binary. It is “bin” for every device.
entry point — the entry point of the algorithm. It’s 0x100 in most cases, but if your parameters structure exceeds 0x100
in size (the sum of the sizes is bigger than 0x100), you will not be able to build the algorithm and will have to adjust the
entry point accordingly. You can check it in the map file located in the same folder as your binary.
file — the name of the algorithm binary.
Jfpinclude href — path to the parameter xml.
supported operations — the operations that the flash supports.

6.6 Device XML

The device XML in the {CodeWarrior}\ CW_ARMv8\Config\flash\devices folder is shown in the following figure.
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<device-file>
<devicel
<content
<device parameters>
<device_type>spicfdevice_typeb
<manufacturerid>-0x0l</mamafacturerids>
</device parameters>
<name>S525F55125< / name’>
<zectors>
<sector count="258" zize="0x40000"/
</=zectors>
<organizations>
<agrganization depth="64M" width="8">

<id>xDxD220</id>
<algorithm>
<fpinclude href="algorithms/S25F5512%.xml" />

<falgorithm>

</organization®

</organizations>
</content>
<fdevice>

fdevice—Ffile>
Figure 5. Device XML

* device_type — the type of the device.

» manufacturerid — this is the ID of the manufacturer. It is unique for all the flash devices of a certain producer.
¢ name - the device name.

* sector count — number of sectors, size — the size of a sector, expressed in bytes (hexadecimal).

* depth — flash size (sector count * sector size), width — the bus width of the device.

¢ id — device id, found in the same table as the manufacturer id.

7 Debugging the flash programmer QSPI algorithm

If the flash programmer QSPI algorithm does not behave the way it was expected to, debugging the algorithm might be
necessary. This section will cover how to enter debug mode for the flash programmer algorithm, as well as the most common
places to check for mistakes.

7.1 Entering debug mode

To debug the algorithm:
1. Configure the target connection to the device on which the algorithm will be tested (For details about how to configure
the connection, see ARM V8 ISA, Targeting Manual).
2. Go to the linker file located in the algorithm (common/linker files/aarché4elf.x) and modify the
___MEMORY_START value to the ws_address used by the device (found in the config file located at { CodeWarrior}
\CW_ARMv8\Config\boards).
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3.

def Config Fiash Devicesa():

# Add QSPI device
gdb.execute{"f1l dewvice

LR TT L LR L ALEl nELETT g

OUTPUT_ARCH(aarch64)
ENTRY( start)

SECTIONS

{
/* Read-only sections, merged into text segment: */
PROVIDE (_ MEMORY START = 0x10000000) ;
. = SEGMENT START("text-segment", _ MEMORY START);

.header : { *(.header) }
-header : { *(.header_utils) }
.start : f *¥{.start) }

Go to the code area you wish to debug and place an assembler halt command (asm (“*hlt 17)) (this will act as a
breakpoint in the algorithm).

retval t
read_id(parameter block t* p_pb)

{

0 Nk

volatile uint32 t auxVal = @;

/* get a pointer to the parameter structure data buffer */
volatile uint8 t* buffer = p _pb->items.c;

/* get a pointer to the QSPI controller address */
QuadSPI_Type *QuadSPI = (QuadSPI_Type*)(intptr_t)p pb->gspi_controller offset;
asm("hlt 1");]
/* initialize the lookup table */
retval t rc = gspi_init(p _pb);
if (rc)
return rc;

Above is an example that wants to debug the id command.

Right-click the project and select Build Project.
Copy the created binary in the {CodeWarrior}\ CW_ARMv8\Config\flash\arm\bin folder.
Connect to the board.
Issue a command that will trigger the breakpoint (in the example above, it would be “fl_id”).
Disconnect.
Enter debugging mode:

a. Create a new Debug Configuration (Run -> Debug Configurations).

b. Create a new GDB Hardware Debugging configuration.

c. Make sure the project and elf file are correct and disable auto build.
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- . " 5
#Debug(ﬁonﬂgurarions i - - R e R & M e g e M

Create, manage, and run configurations ﬁ

Sl Name: QUADSPILFLASH Debug_qgspi
I type filter text
C/C++ Application i
o ey Project:
C/C++ Attach to Application -
[E] C/C++ Postmortem Debugger QUADSPLFLASH
C/C++ Remote Application C/C++ Application:
- GDB Hardware Debugging Debug_qspi\QSPL64b.elf
[£] QUADSPL FLASH Debug_gspi
4 B Launch Group Variables... I l Search Project... } l Browse... J

# New_configuration Build (if required) before launching

[E Main \@ Debugger| b Startup] 1 Source'} 0S Awareness| %5 Other Symbalswi = Trace and Profile| & gommon]

Build configuration: | Select Automatically vl

() Enable auto build

(7) Use workspace settings Configure Workspace Settings...

Filter matched 8 of & items Using CodeWarrior Hardware Debugging Launcher - Select other.. [ Revert I [ Apply I
(@ I Debug i [ Llose ‘

d. In the Debugger tab, uncheck the Execute target initialization file checkbox.
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| Name: QUADSPL FLASH Debug_gspi

|[E Main | % Debugger B Startup | 5 Source OS Awareness| %5 Other Symbols| = Trace and Profile| =l Common)| )
GDB Setup =
GDB Command:

“${eclipse_home}. \ARMvE\gdb\bin\aarch64-fsl-gdb.exe" [Brc:—wse...l I‘ul'ariables...l

Target Connection Configuration

[ |Execute target initialization file

[ Verify memory after download

111

[[] Use launch specific connection _Configure target connection...

Configuration: |L51012A FRDM (1) - |

Core; | CortexA53#0 « | [ | Use all cores

Application Consocle

(") Use separate console for target output and input (@ Use GDB console for target output

|| Synchronize with breakpoints set in GDB console T
[ Force thread list update on suspend -

Using CodeWarrior Hardware Debugging Launcher - Select other.., I Revert ] [ Apply l

[ Debug ] l Close ]

e. In the Startup tab, uncheck Reset and Delay and Load image, and make sure Looad symbols is checked.
10. Your PC will point to the asm(“h1t 1”) instruction. To continue debugging, right-click the next line and select Move
to Line.
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A5 Debug =

4 [c] New_configuration (1) [GDB Hardware Debugging]
4 ¥ QSPI_64b.elf [1] [cores: 0]

read_id{) at gSPL Algorithm.c:471 0x1000
main{) at ARMflash_main.c:53 0x10002af
s "C/Freescale/CW4NET_v2016.01/CW_ARMvS/A

mm

[¢] ARMflash_commands.h (¢ ARMfiash_main.c
volatile uint32 t auxVal = @;

/* get a pointer to the parameter
volatile uint8_t* buffer = p_pb->i

/* get a pointer to the QSPI contr
QuadSPI_Type *QuadSPI = (QuadSPI T
asm("hlt 1");
/* initialize the lookup table */
retval t rc = gspi_init(p pb);
if (rc)

return rc;

/* clear RX/TX buffers */

4

Bl Console &2 Tasks IFL Prablems Executables
New_configuration (1) [GDB Hardware Debugging] "C/I

GNU gdb (GDB) 7.11.1.8.41d8236-b170214 (M
Copyright (C) 2016 Free Software Foundati
License GPLv3+: GNU GPL version 3 or latei

This is free software: you are free to ch

There is NO WARRANTY, to the extent permi =l
and "show warranty" for details. 3
--host=mingw3 =
Type "show configuration"” for configurati =y

This GDB was configured as

|

4 §® Thread #1 1 [core: 0] (Suspended : User Req| ™

Undo Typing

Revert File

Save

Open Declaration
Open Type Hierarchy
Open Call Hierarchy
Quick Outline

Quick Type Hierarchy
Explore Macro Expansion
Toggle Source/Header
Open With

Show In

Cut
Copy
Paste

Quick Fix
Source
Refactor

Declarations
References
Search Text

Make Targets

Resource Configurations
Preprocess

Disassemble

Step Into Selection

Run to Line

Move to Line

Resume at Line

Add Watch Expression...

11. Now, you can step through the code, inspect registers, view memory.

7.2 Debugging process

Ctrl+Z

Ctri+5

F3

F4
Ctri+Alt+H
Ctrl+O
Ctrl+T
Ctri+=
Ctri+Tab

Alt+5hift+W

Ctri+x
Ctrl+C
Ctrl+V

Ctri+1
Alt+5hift+5

Ctrl+F5
Ctrl+R

-

3

»

R oD F| i

rch64-fsl-gdb.exe”

Debugging the application might prove to be a bit challenging. The most common places to check for errors are the

following:

1. The parameter structure: most frequent errors are because of incorrect parameter values. Most frequently, there are two

reasons for this:
* Incorrect value provided in the XML
* Incorrect padding inserted
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The first step is to go to the “Variables” tab and check the values in “p_pb”. If they are not correct, first check if the
values in the XML are correct. If they are correct in the XML but not in the parameter structure, it means there is a
padding problem. Check the addresses in the “Expressions” tab to see if there are any incorrect addresses (current type
size + current address =/= next address). If there are such cases, it means there should be extra padding there (in both

the XML and the algorithm parameter structure).

Expression

4 % pn gParams

9= function
= paddingl

: (= base addr

= num_items

0= result_status
> (= items
. [ gspi_base_addr

)=

=

)=
)=

L

)= i5_nand
()=

-

()=

—

gspi_controller_offset
)= bytes_per_sector

¢9= bytes_per_page

0= number_of sectors
swap_enable
workaround

block_protect_mask
= write_enable_cmd
read_id_cmd

- read_id_dummy

¢9= read_id_length

Type
parameter_block t *
uint32_t
uint32 t
painter_t
uint32_t
retval_t
painter_t
pointer_t
uint32_t
uint32 t
uint32_t
uint32.t
uint8 t
uint8_t
uintg t
uint8_t
uintd_t
uintd_t
uint8 t
uint8_t

)= read_status_register_cn uint8_t
&)= read_status_register_ac uint8_t

)=
[
()=

[ R R -

read_status_register_lel uint8_t
write_status_register_cr uint8_t
write_status_register_at uint8_t

)= write_status_register_le uint8_t

Value
0x10003ef0
268451600
0

{d
268435456

0
fod
tl
0
0
0
6

36'Y
0"\
0o
RV
125F
0"
0no'
0o’
36§
0o’
0o
0o
36'Y
0o

Address
0x10003ecD
0x10003ef0
0x10003ef4
0x10003ef8
0x10003f00
01000304
0x1000308
0x10003f10
0x10003718
0x10003f1c
0x10003f20
0x10003f24
0x10003f28
0x10003f29
0x10003f2a
0x10003f2b
0x10003f2c
0x10003f2d
0x10003f2e
Ox10003121
01000330
01000331
0x10003f32
0x10003f33
0x10003734
0x10003f35

. The QuadSPI LUT registers were not written correctly. This can be a consequence of incorrect values stored in the

parameter structure, or it could be because some commands need extra parameters that are not yet covered by our

structure and XMLs. The LUT registers can be checked in Peripherals -> Device Registers -> QuadSPI.
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i QuadSPLLUTO

» it QuadSPLLUT1

M1t QuadSPI_LUT2

. i QuadSPILUT3

- i QuadSPLLUT4

. 1 QuadSPLLUTS

i1t QuadSPLLUTG

i QuadSPILLUT?

1M QuadSPLLUTE

» I QuadSPLLUTS

it QuadSPI_LUT10
I QuadSPI_LUT11
i QuadSPILUT12
i QuadSPILLUT13
» it QuadSPILUT14
# QuadSPLLUTIS
- I QuadSPLLUT16
» W QuadSPILUT17
W QuadSPILUTLE
- it QuadSPLLUT19
- 1 QuadSPILUT20
- I QuadSPILLUT21
- it QuadSPLLUT22
il QuadSPI_LUT23
1 QuadSPI_LUT24
i QuadSPI_LUT25
it QuadSPILUT26
» It QuadSPLLUT27
i QuadSPILUT28
1 QuadSPILUT29
» it QuadSPILUT30
it QuadSPLUT31
. it QuadSPI_LUT32
- i QuadSPLLUT33
- i1 QuadSPILLUT34
- i QuadSPILUT35
o ! QuadSPLLUT36
- i QuadSPLLUT37
» It QuadSPLLUT38
- 1 QuadSPILUT39
it QuadSPI_LUT40

0x03041808
0x081c0024
000000000
0x00000000
0x9f04081¢
0x00000000
0x00000000
Ox00000000
0x0c042008
0x080c801c¢
Ox 00000000
0x00000000
012042008
0x40200000
0x00000000
Cx00000000
Oxdc042008
0x00000000
Ou00000000
0x00000000
Ox00000000
0x00000000
0x00000000
OxD0000000
0x06040000
Ox00000000
000000000
0x00000000
0w0504011c
0x00000000
0x00000000
Ox00000000
0x01040120
000000000
Ox00000000
0x00000000
OxG5041808
0x080c011c¢
0x00000000
000000000
0x71041808

8 Revision history

0x0

0x0
Ox0

OxD

SEEEEEEE

0x0

EEEEEEEEEEEEEEEEEEEEEEEE

RW
RW
RW
EW
RW
RW
RW
RW
Ew
RW
RW
RwW
RW
RW
RW
RW
RW
RW
RW
RwW
RW
EwW
RW
RW
RwW
RW
RW
RW
RW
EW
RW
RW
EwW
RW
RW
RW
RW
RwW
RW
RW
RW

0x1350310

Revision history

Luok—qp Table register

0x1550314 Look-up Table register

0x1550318
Ox155031c
Ox1550320
0x1550324
Ox1550328
x155032c
O0x1350330
Ox1550334
(x1550338
Ox155033¢
(1550340
Ox1350344
Ox1550348
0x155034c
Ox1350350
01550354
0x1550358
Ox155035¢c
0x1550360
Ox1550304
Ox1550368
0x155036¢
Ox1550370
0x1550374
0x1550378
Ox155037c
(1550380
Ox1550384
0x1550388
0x155038c
01550350
(1550394
Ox1550398
Ox15503%9¢
0x15503a0
Ox13503a4
0x15503a8
Ox15503ac
Ox15503b0

Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
Look-up Table register
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Revision history
This sections summarizes revisions to this document.

Table 1. Revision history

Revision Date Section Description
0 02/2017 Initial public release.
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